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Chapter 1

ReCatIt_Guide

1.1 ReCatIt
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** ReCatIt V2.50 **

Change the words... not the program!

INTRODUCTION

Introduction
System Requirements

THE PROGRAM

Catalog Editor Mode
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Catalog Description Mode
ReCatIt Menus

ADVANCED FEATURES

Advanced Features
Smart Tips!!
Shell Parameters
ToolTypes
The Preferences Window
Preferences and Settings Priority
Smart Display Window
The Vocabulary System

Add-ons! Stuff that a ReCatIt user should not miss!

TRANSLATORS STUFF - FUTURE AND PAST

A note for all ReCatIt.catalog translators!
Please, read this also!!
A brief list of programs catalogs translated using ReCatIt!
Future of ReCatIt and my own dreams about it!
History

AUTHOR
Author info
Greetings

AMIGA FOUNDATION CLASSES!

This program uses the Amiga Foundation Classes

LEGAL STUFF
Standard Disclaimer
Copyrights - Enigma Amiga Run *READ THIS*

1.2 ReCatIt / Preferences and Settings Priority

PREFERENCES AND SETTINGS PRIORITY

At the moment, you have three different ways to configure ReCatIt:

1 ToolTypes

2 Preference Window

3 Shell Parameters

Of course, there should be a sort of priority for the settings, well, here
it is:

1 - ToolTypes are read first
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2 - Prefs are read secondly (and override ToolTypes settings)

3 - Shell parameters are read at last (and override Prefs)

So, if you configure ReCatIt using ToolTypes, be sure that there is no
".prefs" file around.

1.3 ReCatIt / Shell Parameters

SHELL PARAMETERS

ReCatIt can get some parameters from the command line.

Currently the template is:

FILENAME,CDEDITOR/S,CATALOGEDITOR/S,CDFILE/S,
LANGUAGE/K,AUTHOR/K,SD=SMARTDISPLAY/S,AUTOFILL/S

FILENAME - Name of the file to load.

CDEDITOR/S - If present, ReCatIt will start in Catalog Description ".cd ←↩
" Mode

CATALOGEDITOR/S - If present, ReCatIt will start in Catalog Editor ".catalog ←↩
" Mode

CDFILE/S - If present, ReCatIt will threat the file you have provided ←↩
as

parameter as a ".cd" file and not a ".catalog" file.

LANGUAGE/K - Use this keyword to set the default language.

AUTHOR/K - Use this keyword to set the default author name.

SD=SMARTDISPLAY/S - If present, Smart Display Window will be opened at startup ←↩
.

AUTOFILL/S - If present, AutoFill option will be set to on.
See Prefs for more info.

Example:

ReCatIt ReCatIt.cd CDEDITOR CDFILE AUTHOR="Fabio Rotondo" LANGUAGE="italiano"

Will start ReCatIt in Catalog Description Edit Mode, load the ReCatIt.cd file
as a ".cd" file and set AUTHOR name and LANGUAGE.

See Preferences And Settings Priority for further info.
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1.4 ReCatIt / Catalog Info Window

CATALOG INFO WINDOW

Starting from V2.40, you can ask to ReCatIt to show you all
the info it has about a file you have loaded.
This is the use of the Catalog Info Window (shortcut: Amiga + I).

Inside this window, you’ll see all the data related to
the current catalog in memory.

If you wish to change these info, use the "Catalog Data" menu.
See ReCatIt Menus for more info.

1.5 ReCatIt / Supported ToolTypes

TOOLTYPES

Starting from V2.40, ReCatIt can read ToolTypes.
At the moment, supported ToolTypes are:

FONTNAME - Name of the font for ReCatIt Window
Font name *must* end with ".font" extension and
should be written without any brachet (")
Ex. FONTNAME=topaz.font

FONTSIZE - Size of the font.
Ex. FONTSIZE=8

LANGUAGE - Default ReCatIt language.
Ex. LANGUAGE=italiano

AUTHOR - Default ReCatIt author.
Ex. AUTHOR=Fabio Rotondo

SMARTDISPLAY - If you set this ToolType to TRUE the Smart Display ←↩
window

will be opened automatically on startup.
Ex. SMARTDISPLAY=TRUE

AUTOFILL - If you set this to TRUE, the AutoFill option will be
turned on. See Prefs for more info.
Ex. AUTOFILL=TRUE

XPOS, YPOS - These ToolTypes are for Window size and position.
WIDTH, HEIGHT Ex. XPOS=10

YPOS=20
WIDTH=400
HEIGHT=120

See Preferences and Settings Priority for further info.
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1.6 ReCatIt / Smart Display

SMART DISPLAY

Starting from V2.40, ReCatIt offers a new, great, feature:
Smart Display.

In this window, you’ll be able to see in real time the changes
you are making on a certain phrase.

The use is straigth forward, to open the Smart Display Window
you have just to select the "Smart Display" option from the
"ReCatIt Mode" menu (Amiga + D).

Smart Display Window is one of the good idea that CatEdit
implemented and I have stolen and upgraded. ;)

1.7 ReCatIt / Catalogs Translated

CATALOGS TRANSLATED USING RECATIT

This is a list, that I hope will grow soon, of programs catalogs
translated using ReCatIt.

Dirk Neubauer translated:

IconReplacementTool 1.6
ADoc 5.0
MidIt 2.8
NetInfo 1.8
ClassAction 3.5

Sinisa Lolic translated:

YAM

Harry Samwel translated:

ModePro
ModeProPrefs

1.8 ReCatIt / Add-Ons

ADD-ONs

Starting from V2.30, ReCatIt is shared with some stuff not properely
needed by ReCatIt itself, but that should be useful to ReCatIt user:

* DOpus5 "Catalog" FileType:
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This is a FileType (datatype file descriptor) for DOpus5.0+
(it should work also on Opus5 Magellan, but I have not tested
it...)

With this FileType, any time you’ll click on a ".catalog" file,
ReCatIt will be called and it will display the catalog.

In order to have this FileType working, you should have ReCatIt
in the path, so in c: or in another directory assigned to c: ADD.
Otherwise, simply edit the FileType and change the path of ReCatIt.

To have the file type installed, simply copy it in DOpus5:FileTypes
directory.

1.9 ReCatIt / The Future

FUTURE FOR RECATIT

I am strongly supporting this program, because I think it is a very good
piece of software :-)
At least, it works well also on machines where CatComp crashes, for
example...

I have added all the features that users requested me, and that’s the way
I would like to follow for the future.

! I have a dream, I would like to see ReCatIt to become the *official* !
! catalog translation tool used by ATO (Amiga Translators Organization). !
! So I’ll do all my best to improve ReCatIt for their own use, so if you !
! are a member of ATO and would like to see a special feature in ReCatIt !
! just ask me!!! !

Please, if you translate something using ReCatIt, tell me the name of the
program you’ve translated, and I will insert it among the list of programs
catalogs translated using ReCatIt!

That’s the future of ReCatIt. I hope to see it bright... long live and
prosper.

Fabio Rotondo

1.10 ReCatIt / Smart Tips

SMART TIPS

How to:

Convert ’.cd’ -> ’.catalog’
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Convert ’.cd’ -> ’.ct’

Convert ’.catalog’ -> ’.cd’

Convert ’.catalog’ -> ’.ct’

1.11 ReCatIt / Smart Tips / ’.cd’ -> ’.ct’

Quickly convert ".cd" to ".ct"

1 - Load ReCatIt

2 - Press ’Amiga + 2’ (set ReCatIt to work in ".cd" mode.)

3 - Select "Open ’.cd’" from "Project" menu (Amiga + O)

4 - Load the ".cd" file

5 - Set Catalog Name, Author, Language, Version and Revision
using the "Catalog Data" menu

6 - Save it by pressing "Amiga + T"

1.12 ReCatIt / Smart Tips / ’.catalog’ -> ’.ct’

Quickly convert a ".catalog" to a ".ct" file

Simply follow these steps:

1 - Load ReCatIt

2 - Press ’Amiga + 2’ (set ReCatIt to work in ".cd" mode.)

3 - Select "Load ’.catalog’" from "Project" menu (Amiga + L)

4 - Load the ".catalog" file

5 - Save the ".ct" file, by pressing "Amiga + T"

1.13 ReCatIt / Smart Tips / ’.catalog’ -> ’.cd’

Quickly convert a ".catalog" to a ".cd" file

Simply follow these steps:

1 - Load ReCatIt

2 - Press ’Amiga + 2’ (set ReCatIt to work in ".cd" mode.)
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3 - Select "Load ’.catalog’" from "Project" menu (Amiga + L)

4 - Load the ".catalog" file

5 - Save it by pressing "Amiga + W"

1.14 ReCatIt / Smart Tips / ’.cd’ -> ’.catalog’}

Quickly convert a ".cd" file to a ".catalog"

Simply follow these steps:

1 - Load ReCatIt

2 - Press ’Amiga + 1’ (set ReCatIt to work in ".catalog mode".
This is default mode, when loading ReCatIt)

3 - Select "Open ’.cd’" from "Project" menu (Amiga + O)

4 - Load the ".cd" file

5 - Press Amiga+F ("Fill empty messages" from "Actions" menu)

6 - Change Catalog data using "Catalog Data" menu

7 - Save the ".catalog" by pressing Amiga+S (Save ".catalog" in
"Project" menu)

1.15 ReCatIt / Vocabulary Extension

VOCABULARY EXTENSION

Starting from V2.30, ReCatIt has a new, powerful feature: Vocabulary.
One of the most common problems while creating a ".cd" file from a
".catalog" was given by the fact that some "strange" chars weren’t
converted (filtered) correctly.
During automatic constant creation, ReCatIt takes the first word of the
message it is going to translate and does these steps:

1 - Takes that word and makes it upper case (ex. "home" to "HOME")

2 - Adds "MSG_" prefix (ex. "MSG_HOME")

3 - Looks inside the string for "Strange" chars.

Ex. suppose the first word would be "That’s", the char "’" is
a so called "strange" char. During the steps describe above,
following things should happen:

1 - "That’s" -> "THAT’S"

2 - "THAT’S" -> "MSG_THAT’S"
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3 - "MSG_THAT’S" -> "MSG_THATS"

In this case, the "’" char has been translated to "".

Before the introduction of the Vocabulary system, you would be forced to
accept the way I decided to do things, from now on, you can create your
own translations. So, if you want, for ex., that the "’" char is translated
in "_" you can, and "MSG_THAT’S" will be "MSG_THAT_S" !!

HOW TO USE

ReCatIt loads its vocabulary from an external file, called

"ReCatIt_Vocabulary.dat"

This file can be stored in these dirs:

PROGDIR: (<- The same dir where the program is stored)

"" (<- The same path where the program is)

ENV: (<- The usual ENV: directory)

so you should have no problem having ReCatIt finding it.

HOW TO CREATE/EDIT THE FILE

"ReCatIt_Vocabulary.dat" file, is a standard ASCII file.
It is defined in this way:

"fromchar" "tochar"

Which means:

fromchar - Char to filter

tochar - What to insert instead of "fromchar"

If you want "fromchar" simply deleted, set "tochar" to "NONE".

Please note:

1 - from and to char MUST be enclosed in brackets (" ")

3 - You can change SEQUENCES of chars also:

"%S" "NONE"

Will change "%S" into ""

4 - To set an empty char, write "NONE"

5 - "tochar", if any, should be in UPPER CASE. Ex. "à" "A"
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6 - You can divide "groups" of chars using blank lines

7 - You can add comments using ";":

; This is a comment line
"à" "A"

Here there is an excerpt from currently "ReCatIt_Vocabulary.dat" file:

; Strange Chars

"%S" "NONE"
"%LD" "NONE"
"%L" "NONE"

; Hello world

"à" "A"
"è" "E"
"é" "E"
"ì" "I"
"ò" "O"
"ù" "U"

NOTE

- You can add/del/change any line of this file.

- DON’T ADD to the Vocabulary file these chars:

*

"

Because they are already automatically filtered by ReCatIt

1.16 ReCatIt / Note to all translators

A NOTE TO ALL TRANSLATORS!

First of all, thank you.

Thank you for taking your time translating ReCatIt.catalog into
different languages.

Now, some quick notes to do a better work next time:

1 - Do NOT change ReCatIt.catalog version.

From now on, ReCatIt.catalog version will be alligned to ReCatIt
program version.
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2 - Change the string "By Fabio Rotondo" with your own name.

3 - Send me the catalog.

NOTE: I do already have a french, svenska and german translators, so
please *DO NOT* send me any other german or french catalog, because I
will trash them. If, for some reason, a translator will quit his
work, then I’ll look for someone else.

Thank you again!

1.17 ReCatIt / Please Read This

PLEASE, READ THIS!

I have seen a lot of catalogs for many programs uploaded on Aminet recently.

Please, if you have used or are still using ReCatIt to translate them, please
tell me!!

So, I can create a list of programs that have been localized using ReCatIt!!

Thank you for your time and attention,

Fabio Rotondo (fsoft@intercom.it)

1.18 ReCatIt / Introduction

INTRODUCTION

Some time ago Vit Sindlar asked me to write a program to modify the
".catalog"s files. Well, here it is. ReCatIt is extremely easy to
use, powerful and fast.

It is extremely useful for programmers, who intend to localize their
programs, and also for people willing to translate a ".catalog" from
one language to another.

Its main features are:

* Imports following formats:

- ASCII
- ".catalog"
- ".cd"
- ".ct"

* Exports in the following formats:

- ".catalog"
- ".cd"
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- ".ct"

* Can create constants files the following languages:

- C
- ASM
- E
- Blitz Basic.

* Can be used in these different ways:

- As a ".catalog" Editor
- As a ".cd" Editor
- As a ".ct" Creator

* Modularity:

- Module: Vocabulary for flexible user extension

* Customizable:

- ToolTypes

- Prefs

I hope you will like it.

Please note: has mentioned in copyright notice this
program is e-mail ware: if you like it (and use it), please send me an
e-mail, or a postcard. My address is:

e-mail: fsoft@intercom.it

Snail mail: Fabio Rotondo
C.so Vercelli 9
28100 Novara
ITALY

1.19 ReCatIt / Preferences

PREFERENCES

Starting from V2.40, ReCatIt has a Preferences window, you can use
to change/customize ReCatIt behaviours.

GENERAL PREFERENCES

Start Mode: how ReCatIt should open. Default is Catalog Editor Mode, but
you can change it to "Catalog Description Mode".

Default Language: insert your preferred language here (ex. "italiano")

Default Author: the default name of the author (ex. "Fabio Rotondo")
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Open Smart Display: by checking this gadget, you’ll tell ReCatIt
to open Smart Display Window automatically after
loading.

FONT ATTRIBUTES

You can change ReCatIt font by action upon these config fields.
To be safe, I strongly suggest you to use the "R" gadget which will
open a Font Requester and will mind of setting the right fields for
you.
Anyway, if you are a professional user, you can also type in the
name of your desired font and size by hand in "Font Name" and "Size"
fields.

WINDOW POSITION AND SIZE

Using these fields you can change the default position and size values
of ReCatIt window. The fastest way to do so, is simply to pos the
ReCatIt window where you want it to be, to size it as you like and then
to press the "Grab" gadget.

Alternatively, you can insert your numbers directly inside the gadgets
by hand.

Note: setting a value of -1 means default.

CATALOG EDITOR PREFS

AutoFill Messages
Importing ".cd" files: by checking this gadget, anytime you’ll load

a Catalog Description ".cd" file inside ReCatIt
while you are in "Catalog Edit Mode", will force
the performing of a "Fill Empty Messages"
automatically.

Save Catalogs in LOCALE: dir: by checking this gadget, when you save
a ".catalog" file, the default path will be
"LOCALE:Catalogs/<language_of_the_catalog>/"

"Save" gadget: opens a Save File Requester. ReCatIt will look for a
file called "ReCatIt.prefs" in "ENV:" and "PROGDIR:"
so, save this file in the ReCatIt directory.

"Use" gadget: use the current preferences (but they will get lost as
soon as you close ReCatIt)

See Preferences And Settings Priority for further info.



ReCatIt_Guide 14 / 25

1.20 ReCatIt / System Configuration

System Configuration

To run ReCatIt you’ll need a machine with AmigaOS2.0+

That’s all. Please, note that for very big files, I suggest you to
have at least 50k of free memory :)

Of course, if you run it on a Wind*ws system it will crash (before you will
be able to run it you would have to rename ReCatIt into "RECATIT.EXE"
because it is the only way Windoze will recognize is as an executable :)

1.21 ReCatIt / Catalog Editor Mode

CATALOG EDITOR MODE

When in "Catalog Editor Mode" you’ll be able to edit and create .catalog
files.
The .catalog editor is mainly composed by a listview gadget where all
the messages of the .catalog will appear, and a string gadget, where you
can edit/modify/write the new message.

! ReCatIt supports also multi line messages, and the "\n" is converted into !
! the char "§". So multi line messages will be prompted in a single line, !
! with the "§" char delimiting new lines. !

You can use the "§" char while creating new strings messages.

To see how the new message will look like, you can do two things:

1 - Press the "S" gadget.
By pressing this gadget a requester will pop-up showing the
final "look and feel" of the message.

2 - Activate the Smart Display Window (Amiga + D), where the current
message will be shown.

! You can move in the listview gadget using the cursor keys. To activate !
! the string gadget, press the "n" key on the keyboard while the listview !
! is active. !

The other gadgets in the window will show you some info:

"Int. Num:" - Shows you the "internal" number of the message: you cannot
change it.

"Elements:" - shows the total number of messages present in the catalog.

"Orig:" - shows the original message.
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The "F" gadget next to the "Orig:" text gadget is a "single fill" option.
Pressing this button, the message shown in the "Orig:" text field will be
copied into the "New:" string gadget.

! Please, note that this is a "single fill", that means that just this text !
! will be copied into the "New:" string gadget and not all catalog. !
! To copy all catalog, use the menu option "Fill Empty Strings". !
! The "F" gadget does not check whether the "New:" string field is empty or !
! not: all data will be lost! !

NOTE: to avoid Enforcer’s hits, all the %s and %ld will be set to NULL.
So you can see messages like: "Program V%ld.%ld"

appear: "Program V0.0"

That’s completely OK.

! Pressing Amiga + I ("Catalog Data"->"Catalog Info" menu item) you can see !
! important info about your catalog. Please note that those info can be !
! changed using the "Catalog Data" menu. !

1.22 ReCatIt / Catalog Descrition Mode

CATALOG DESCRIPTION MODE

One of the most requested features in ReCatIt was the ability to
edit/create so called "Catalog Descriptors" or ".cd".
Descriptors are simple ascii files containing the name of the
constant variable and the default string.

Starting from V2.00, ReCatIt has this new feature: you can edit
existing ".cd"s, create catalogs from them and even create
".cd"s from ".catalogs" !!!

The interface is very close to the Catalog Editor

The first part will contain all the CONSTANT NAMES of the phrases you are
going to localize.

Below you’ll find these gadgets:

Constant: here you can put your constant name, for example: MSG_HELLO.

Int.Num: it is the VALUE of the constant, if you set it to -1, ReCatIt
will assign to the constant the next ordinal number avaible.

Msg: is your message.

S: shows the message.

"New": creates a new empty message.

Elements: shows how many messages are present at the moment.
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"Del": deletes selected message.

CREATE A NEW MESSAGE

Every message in "Catalog Description Mode" is made by three different
parts:

- Constant Name: it is the numeric constant you’ll need to identify
the messages later (usually referencing it inside
a program of yours).
Constant name should contain only "a...z" and "A..Z"
chars, anyway, while creating constant names,
ReCatIt will check them for you :-)

- Int. Num: it is the internal number of the phrase, you can leave
it to "-1" (default value), so ReCatIt will assign to
it the first valid value.

- Msg: it is the real message. It can be a multi line message,
and you can use the "§" char to define a new-line.

To see the "look and feel" of your message, you can:

1 - Press the "S" gadget, opening a requester showing your message.

2 - Open the Smart Display Window (Amiga + D) that
will show you the message, every time you change it.

To create a new message, follow these steps:

1 - Press the "New" gadget

The constant name "MSG_NEWMESSAGE" will appear in both lister and
Constant string gadget field.

2 - Change the name of the constant inside the string gadget field.

3 - Insert your message.

1.23 ReCatIt / Menu

MENU

Starting from V2.40, menus were completely reorganized.
The actual menu layout is this:

* "Project"

+ "Load Catalog" - Opens a ".catalog" file.

+ "Save Catalog" - Saves a ".catalog" file.
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+ "Preferences " - Open the Prefs window.

+ "About " - -+
|

+ "About AFC " - -+-- Just three about windows
|

+ "Greetings " - -+

+ "Quit " - Ends the program

* "Actions"

+ "Kill all new messages " - Clears all the messages you have translated
in the catalog.

+ "Fill empty strings " - Fills all the empty messages (what you
haven’t yet translated) with the original
message. This is very useful if you are
not going to translate a whole catalog in
one single step.

+ "Clear All " - It just clears current catalog in memory.

+ "Find " - Opens the Find Window requester.

+ "Find Again " - Continues the search operation already started.

* "Catalog Data"

+ "Name " - Allows you to change Catalog name.

+ "Language " - Allows you to change Catalog language.

+ "Author " - Allows you to change Catalog author.

+ "Version " - Allows you to change Catalog version.

+ "Revision " - Allows you to change Catalog revision.

+ "Catalog Info " - Shows the Catalog Info window.

* "Import"

+ "Import Catalog Description ".cd" File" - Opens a ".cd" file

+ "Import Catalog Translation ".ct" File" - Opens a ".ct" file

+ "Convert" - Is a sub menu, with these items:

- ASCII -> ".catalog" - Translate an ascii file into a ".catalog"
file. See Advanced Features

- ASCII -> ".cd" - Translates an ascii file into a ".cd" file.
See Advanced Features
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* "Export"

+ "Catalog Description ".cd" File" - Saves a ".cd" file

+ "Catalog Translation ".ct" File" - Saves a ".ct" file

+ "AmigaE Constants " -\
\

+ "C Constants " ---\
> These are for constants export.

+ "ASM Constants " ---/
/

+ "Blitz Constants " -/

* "ReCatIt Mode"

+ " Catalog Editor " - Switch to Catalog Editor Mode

+ " Catalog Descriptor Editor " - Switch to Catalog Descriptor Edit Mode

+ "Smart Display " - Opens the Smart Display window.

NOTE: ReCatIt will handle correctly also messages divided in more than
one single line, usually divided by a Line Feed (ASCII: 10) char.
To allow you to enter these messages in a string gadget, ReCatIt
changes the ASCII 10 char into a "§". So any moment you’ll see a
"§", it will mean that there is a Line Feed char. You can use "§"
to insert Line Feeds inside your own messages (they will be
translated into ASCII 10 during the saving process)

1.24 Disclaimer

DISCLAIMER

NO WARRANTIES

ReCatIt and accompanying written materials are provided "as is", without
warranty of any kind. To the maximum extent permitted by law, author
declaim all warranties, either express or implied, including but not
limited to implied warranties of merchantability, fitness for a
particular purpose and noninfringment. The entire risk arising out
of the use or performance of ReCatIt and any accompanying written
materials remains with you.

NO LIABILITY FOR CONSEQUENTIAL DAMGES

To the maximum extent permitted by applicable law: in no event shall the
author or their suppliers be liable for any damages whatsoever (including,



ReCatIt_Guide 19 / 25

without limitation, damages for loss of business profits, business
interruption, loss of business information, or other pecuniary loss)
arising out of the use of or inability to use ReCatIt, even if the author
have been advised of the possibility of such damages. Because some
states/jurisdictions do not allow the exclusion or limitation of liability
for consequential or incidental damages, the above limitation may not
apply to you.

1.25 ReCatIt / Copyright

COPYRIGHT

ReCatIt is EmailWare, if you like it, please send me an e-mail, or a
postcard of your home town.

My address is:

e-mail: fsoft@intercom.it

snail mail: Fabio Rotondo
C.so Vercelli 9
28100 Novara
ITALY

You can freely copy and share this product as long as you ship the original
archive and you don’t ask for any fee for the copy.

NOTE:

Enigma Amiga Run IS NOT ALLOWED TO SHARE AND INCLUDE THIS PROGRAM IN
ANY KIND OF ITS MAGAZINES, ON CD-ROM OR DISKS. THEY ARE KILLING THE
AMIGA HERE IN ITALY, AND I DO NOT WANT THEM TO SHARE MY PRODUCT ON
THEIR FUCKING MAGAZINES.

1.26 ReCatIt / Author Info

AUTHOR INFO

ReCatIt has been written by me: Fabio Rotondo.

If you want to get in touch with me, please, send an e-mail or a letter
to the following address:

e-mail: fsoft@intercom.it
snail mail: Fabio Rotondo

C.so Vercelli 9
28100 Novara
Italy
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see also: http://www.intercom.it/~fsoft - my home page
http://www.intercom.it/~fsoft/ablast.html - Amiga Blast WEB ←↩

Magazine
http://www.intercom.it/~fsoft/afc.html - Amiga Foundation ←↩

Classes

1.27 ReCatIt / Greetings

GREETINGS

Sara - My girlfriend

Mik and Gio from ClassX

Kronos The Wizard

Commando Unlimited

Freddy Group

Wouter van Oortmerssen

Jason Hulance

Paolo Agazzone

Maury the teacher

SPECIAL GREETINGS

Vit Sindlar - for suggesting me the ReCatIt idea

Sinisa Lolic - for his hrvatski translation of ReCatIt.catalog
Frits Letteboer - for his dutch translation of ReCatIt.catalog

Marco De Vitis - for the new ReCatIt_Vocabulary.dat file and
his bug reports / suggestions.

Harry Samwel - for his svenska translation of ReCatIt.catalog
for all his feedback and ideas.
Many V2.40 new features come from him. :-)

AND FOR THEIR FEEDBACK

Massimo Marino
Lionel Garcia
Daniele Peri
Mistrot Jean-Philippe
Eric Bilodeau
Gustav Gnosspelius
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Dirk Neubauer
Francesco Agnoli

1.28 Amiga Foundation Classes

AMIGA FOUNDATION CLASSES

What are the Amiga Foundation Classes

"Amiga Foundation Classes" (AFC from now on) is the name of a library of
Object Classes designed to manage the several features of Amiga. Each
Class will constitute an interface between the programmer and a particular
aspect of the Amiga Operating System, trying to make the design and the
coding of a program for the Amiga OS computers easier. The AFC have been
also designed to assure a quicker porting of the Amiga programs on the
future Amiga-Compatible Operating Systems. See section 2.4 for more infos.

What are the Amiga Foundation Classes for

We have designed the AFC for different reasons: first of all the necessity
of fully exploiting the object oriented programming (OOP), that allows to
"recycle" code using it in other Classes or in other programs. The
recompilation of the AFC on future computers with an Amiga-Compatible OS
will allow a quicker porting of software products. See section 2.4 for more
infos.

Who will use the Amiga Foundation Classes

The AFC will be available to all programmers using a language supporting
the OOP. The AFC can be used freely in FreeWare, ShareWare, PD or
Commercial programs without paying any royalty. Probably, in the final
version of the (C)Copyright of the AFC we will ask to programmers that use
them in their code to include a message of the form "This program uses the
AFC", but we have not decided it yet.

Future of the Amiga Foundation Classes

The AFC have been designed to warrant a reliable base of Objects to be used
in the future Amiga-Compatible machines: by recompiling the AFC source
code will be possible to obtain an excellent library of Classes with which
one can easily build applications for the new computers. The advantage of
using Classes of objects over the Operating System calls is due to the fact
that such Classes work as an "interface" between the OS and the programmer:
people that programmed on the Amiga using the AFC will bring their code on
the new machines by simply recompiling the sources and using the AFC
version implemented on the new computer on which they are working. Thank
to the AFC, programmers will save a lot of time (otherwise spent in
learning the new OS) and will keep on using the same Classes with the same
sintax and the same behaviour. This implies, at least in our intentions,
that the software will be developed better and in a shorter time. The risk
that every new Operating System has to face, when it first comes to life,
is the lack of professional software. Thank to the AFC it will be possible
to provide in brief time professional products for these new OS.

Interfacing with new Amiga OS Compatibles
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It’s our intention to freely supply developers of Amiga-Compatible OS with
the source code of the AFC, be they Phase5, VisCorp, Be Inc., AROS, p-OS,
PIOS, etc. Indeed, we are persuaded that the future of a new machine,
possibly not depending on Microsoft, is to be found in the possibility of
having in a short time software products of a professional quality. Thus
the AFC sources will be provided to every OS developer that will ask for
them. Then the particular implementation will be examined by the
supervisors of AFC that will give their approval and allow the
distribution. See section 5.0 for more infos.

For more info, see: http://www.intercom.it/~fsoft/afc.html

1.29 ReCatIt History

HISTORY

V2.50 - ENH: Now the "Find..." requester does not appear anymore if the current
catalog is empty.

ENH: General enhancements all around, now RCI is easier to improve to
the new V3.0.

FIX: Searching an empty catalog used to generate an Enforcer’s hit.
FIX: There was a strange behaviour combo that used to appear when in

"Catalog Description Mode" the user change the constant name of
a message.

V2.40 - ADD: Catalog Translation ".ct" files import routine!
ADD: Keyboard control!
ADD: ToolTypes support!
ADD: Progress bar in all time-taking operations.
ADD: Prefs window!
ADD: New Menu "Catalog Data" allows you to change all catalog’s data

in a easier way.
ADD: Find option!
ADD: Catalog Info Window
ADD: Smart Display Window
ADD: Croatian (Hrvatski) catalog.
ADD: Dutch catalog.
ENH: Completely rewritten *new* Amiga Guide documentation.
ENH: Save catalog routine now automagically creates the version string.
ENH: Catalog Translation export routine now sets the right date

automatically.
ENH: "Vocabulary" System. Now you can:

- Leave "blank" lines between chars to convert definitions
- Add comments using the ";" char as the first char of the line.

ENH: Marco De Vitis enhanced the "ReCatIt_Vocabulary.dat" file adding some
chars and cleaning up everything a bit. Thank you Marco!

ENH: In "Catalog Description" mode, the costant name is trimmed against
white spaces on the right of the string.

ENH: Now Drag and Drop recognizes ".cd" and ".ct" files (or, at least,
it tries :-)

FIX: "Fill Empty Strings" now works _only_in ".catalog" edit mode.
FIX: There was an error message which did not trig a call to

locale.library (ie. it was always in English)
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FIX: Importing ".cd" routine didn’t free previous catalog loaded.

V2.30 - ADD: Vocabulary , more flexible and modular way to convert catalogs.
ADD: Smart Tips in documentation.
ADD: Add-Ons section in documentation.
ADD: DirectoryOpus 5 FileType "Catalog".
ADD: Icon to "ReCatIt" directory.
ENH: Great docs!
ENH: "ASCII -> ".cd" import: now checks for duplicated constant names.
ENH: "ASCII -> (anything)" import very sligthly
ENH: diplay data routine.
ENH: ".cd Editor": now it checks for doubles while creating Constant

names.
ENH: "Clear All" menu command.
ENH: Now "drag & drop" works perfectly!!! Thank you to Jason Hulance

for being so quick in fixing the EasyGUI problem.

V2.25 - (Beta release, given to beta-testers only)

ADD: Now ReCatIt checks against empty strings before saving
ADD: Export mode in ’.ct’ format!
ENH: Now ReCatIt filters also "aeiou" with humlauts (German chars)
ENH: ".cd" Exporting routine now smarter.
FIX: Fixed a string mispelling in ’ASCII -> ".cd"’ message
FIX: ".catalog" exporting routine sometimes mixed up messages numbers...
FIX: Constants exporting routine sometimes mixed up messages numbers...

V2.20 - (Beta release, given to beta-testers only)

ADD: Now ReCatIt has a standard version string.
ENH: Drag and Drop checks. It still doesn’t work properely on standard

Workbench, but it is not a ReCatIt problem, but EasyGUI’s one.
Jason Hulance is fixin it (I hope :-)

ENH: ".catalog" -> ".cd" convertion
ENH: Now ReCatIt checks against duplicated constants name while

converting from ".catalog" -> ".cd"

V2.10 - ADD: Now you can pass parameters with Command Line
ADD: "Screaming..." message
ADD: "F" gadget (Single fill) in the "Catalog Editor" window
ADD: French catalog
ADD: Deutsch catalog
ENH: The code has been tuned up and optimized somewhere.
ENH: Better Messages to Const conversion.
ENH: Better docs.
FIX: ".cd" and ".catalog" import: now all gadgets are updated correctly.

V2.00 - ADD: Added ".cd" (Catalog Descriptor) options.
ADD: Added ".cd" Editor.
ADD: Now ReCatIt can load/save in ".cd" and ".catalog" format.
ADD: ReCatIt is completely localizable.
ADD: "ReCatIt.cd" and "ReCatIt.catalog"
ADD: Converter ASCII -> ".cd"
ADD: Converter ASCII -> ".catalog"
ADD: Automatic Constant Name generator
ADD: ReCatIt can export Constants in Blitz, AmigaE, C and ASM format.
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ENH: Better docs.
FIX: Sometimes the save catalogs routine would mess things up...

V1.60 - ADD: Added ’S’ gadget to both Original and New text, so you can see
"on the fly" how the new text will be displayed.

V1.50 - ADD: New Actions menu
ADD: ’Fill all empty messages’ option
ADD: ’Kill all new messages’ option
ADD: ’Clear all’ option
ADD: Confirmation requester before loading a catalog upon another
ADD: ’Saving...’ message window
ENH: Now window is automatically activated after a drag & drop operation
ENH: Documentation revised
FIX: ’Save’ option now works perfectly.
FIX: ReCatIt has no more enforcer’s hits :)

V1.00 - First Aminet release

1.30 ReCatIt / Advanced Features

Advanced Features

Starting from V2.00, ReCatIt offers some nice features to programmers, like the
opportunity of creating ".catalogs" or ".cd" from a simple text file.

Here’s how:

* The text file MUST be in standard ASCII.

* A message is ALWAYS considered one line long.
Multi lines messages MUST end every line with a "\" char.
NOTE: last line should not have the "\" char.

* Use %s to insert string, %ld to insert decimals and all the usual %chars
defined.

* Use \n to describe a new line.

* Blank lines are ignored.

Example:

--------- ASCII FILE STARTS THE NEXT LINE--------------
Hello
This is the second message
This is the third
Look\n\
This is a multiline\n\n\
Message!
--------- ASCII FILE ENDS HERE -----------------------

Use Menu "Actions/Convert" to create both ".cd" and ".catalogs"
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1.31 ReCatIt / Find

FIND OPTION

Starting from V2.40, you can search a special sequence of chars
inside a catalog, using the new _great_ ReCatIt Find feature.

It is as simply as to select the "Find" option in the "Actions" menu.

A requester will pop up prompting for the string to search.

! Please note that ReCatIt uses AmigaDOS search capabilities, so !
! you *MUST* add "#?" if you are not looking for a very specific !
! string. !

For example: suppose you want to find all MSG_EMPTY inside a ".cd"
file. Insert:

MSG_EMPTY#?

If you want to find MSG_EMPTY001, just type:

MSG_EMPTY001

All common AmigaDOS wildcards will apply.

NOTE:

- Search is NOT case sensitive.
- To continue a started search, select the "Find Again" option.
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